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Viewing PDS Images and Exporting to 
Other Formats 
PDS Geosciences Node  January 2024 

 

First-time users of Planetary Data System (PDS) data sometimes ask, “My software doesn’t read PDS4 
data. Why aren’t the data archived in the format that my software accepts?” There are two important 
reasons for this. First, PDS archive data are saved in non-proprietary formats for long term stability and 
access. Second, image data often contain science information that cannot be stored in a JPEG or PNG 
format. Because of this, users may turn to specialized software to work with archive images. Sometimes 
it is convenient to convert an archive image to a PNG or JPEG at the expense of this information for the 
sake of quickly viewing the image. Generally, the removal of the extra information makes these browse 
images unfit for scientific research, but they are useful for gaining a better understanding of the data 
product before delving deeper and working with the archive image itself. This document provides a brief 
description of techniques for viewing PDS images and converting PDS images into other formats.  
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Frequently Asked Questions 

Where can I get help? 
Questions about the information in this document, or questions about PDS holdings in general, may 

be directed to the PDS Geosciences Node at geosci@wunder.wustl.edu. Additionally, the Geosciences 

Node maintains the PDS Geosciences Node Community Forum. If you frequently work with our data, 

consider joining the forum and posting your questions there. 

Are PDS data files and images free? 
Data sets archived in the PDS are in the public domain. PDS data sets are online and may be downloaded 

and used by anyone for free.  

How do I cite PDS data and images? 
PDS3 data and PDS4 data are cited differently. Refer to Citing PDS4 Data or Citing PDS3 Data for details.  

What is the difference between PDS3 and PDS4? 
PDS4 is the current archiving standard of the PDS, which replaced PDS3 in 2011. PDS4 has been 

endorsed by the International Planetary Data Alliance as the recommended archiving format for 

planetary data. PDS3 and PDS4 have different archiving structures, so different terms are used to refer to 

parts of PDS3 and PDS4 archives. In PDS3, typically there are data sets which contain volumes containing 

products. Label files in PDS3 have .lbl file extensions and their content uses object description language 

(ODL) format. In PDS4, bundles contain collections which contain products. Label files in PDS4 use 

Extensible Markup Language (XML) format and .xml or .lblx file extension. The PDS is actively migrating 

existing PDS3 data sets to PDS4. That said, PDS3 data still make up a significant portion of PDS holdings, 

and PDS3 labels are often retained in data sets converted to PDS4 format. This document will cover 

viewing both PDS3 and PDS4 images.  

For more details visit the general PDS website. 

Are browse images already available? 
Browse versions of various PDS products are sometimes provided for user convenience in PDS archives. 

It can be worth checking if the browse versions already exist and may meet your initial review needs. 

Browse files can be found in an archive’s browse or extras subdirectories. For example, MSL ChemCam 

browse images are found in the follow subdirectory of the corresponding data set: 

https://pds-geosciences.wustl.edu/msl/msl-m-chemcam-libs-4_5-rdr-v1/mslccm_1xxx/browse 

If browse versions do not exist, there are two options if you want to get a visual idea of the data you are 

working with. You can either create a browse version or use PDS software to view the standard PDS 

formatted image. The PDS Transform and GDAL sections of this document cover how to transform PDS 

formatted images to more readily viewable browse image formats like PNG, JPG, and TIF. The sections on 

using PDS4 Viewer and NASA View demonstrate viewing PDS formatted images, which can be exported 

to other formats.  

 

mailto:geosci@wunder.wustl.edu
https://geoweb.rsl.wustl.edu/community
https://pds.nasa.gov/datastandards/citing/
https://pds.nasa.gov/datastandards/pds3/citing-pds3-data.shtml
https://pds.nasa.gov/datastandards/documents/
https://pds.nasa.gov/datastandards/pds3/standards/
https://ipda.jpl.nasa.gov/
https://pds.nasa.gov/datastandards/pds3/standards/sr/Chapter12.pdf
https://pds.nasa.gov/datastandards/pds3/standards/sr/Chapter12.pdf
https://pds.nasa.gov/datastandards/about/
https://pds-geosciences.wustl.edu/msl/msl-m-chemcam-libs-4_5-rdr-v1/mslccm_1xxx/browse
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Is there a list of software that works with PDS images? 
Here is a list of widely available tools at the time of writing. Software described in this document are 

denoted by an asterisk (*).  

Free 

• *The PDS4 Viewer is a general visualization tool that can read PDS4 images, tables, arrays, and 

labels. 

• *NASAView PDS3 Viewer is a GUI tool for reading PDS3 images, tables, arrays, and labels.  

• *The PDS Transform tool is a Java-based command-line tool for transforming PDS3 and PDS4 

product labels and data into other formats. 

• *GDAL is a translator library for raster and vector geospatial data formats. 

Advanced Free options (usage details not provided in this document) 

• USGS Integrated Software for Imagers and Spectrometers (ISIS) 

• Planetary data reader (Python Library) 

• PDS Small Bodies Node Python PDS4 Tools 

Commercial 

• NV5 Geospatial ENVI/IDL supports some PDS images natively with the option to manually enter 

format details. 

• ESRI ArcGIS supports some PDS images natively with the option to manually enter format details. 

• MathWorks MATLAB can be used for numeric processing of image data. Format details must be 

manually entered.   

User Guides and Software Interface Specification Documents 
When you are starting to work with a dataset, it is worthwhile to read the software interface 

specification (SIS) document for the bundle/volume. For a highly derived dataset like a Planetary Data 

Archiving, Restoration, and Tools (PDART) project, the data provider may provide an archive user guide 

or aareadme.txt file instead of a SIS. SIS documents and archive user guides contain useful information 

for better understanding data products and their intended uses, and the documentation can often 

answer questions you might have when first getting started. These files are typically in a document 

directory, with the PDS bundle/volume. For example, to access the SIS that describes the CRISM MRTDR 

data products we will use for the GDAL section later, you would first navigate to the data set level archive 

at the Geosciences node: https://pds-geosciences.wustl.edu/mro/mro-m-crism-5-rdr-mptargeted-v1/. 

Then navigate to the volume you are interested in (in this case mrocr_4001) and access the document 

subdirectory. Within the document directory, you will find the associated SIS (crism_dpsis.pdf). A similar 

approach can be followed for other data sets/bundles. 

 

https://sbnwiki.astro.umd.edu/wiki/PDS4_Viewer
https://pds.nasa.gov/tools/about/pds3-tools/nasa-view.shtml
https://nasa-pds.github.io/transform/index.html
https://gdal.org/index.html
https://isis.astrogeology.usgs.gov/7.0.0/index.html
https://github.com/MillionConcepts/pdr
https://sbnwiki.astro.umd.edu/wiki/Python_PDS4_Tools
https://www.nv5geospatialsoftware.com/Products/ENVI
https://www.esri.com/en-us/arcgis/products/arcgis-online/overview
https://www.mathworks.com/products/matlab.html?s_tid=hp_products_matlab
https://pds-geosciences.wustl.edu/mro/mro-m-crism-5-rdr-mptargeted-v1/
https://pds-geosciences.wustl.edu/mro/mro-m-crism-5-rdr-mptargeted-v1/mrocr_4001/document/crism_dpsis.pdf
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Example CRISM MRTDR SIS document (crism_dpsis.pdf). 

Image Metadata 
When working with images in PDS format, you may need to know the image’s structure. This information 

is found in the label that accompanies and describes the image. Each data product in a PDS archive has a 

label with metadata that describes the file content and format. A PDS4 format image product has an 

XML label file separate from the image data file. A PDS3 format image may have an attached label file 

preceding the image bytes or a separate (detached) label file ending with a .lbl file extension. Below is an 

example of a part of a PDS4 XML label for an InSight Instrument Context Camera image:  

https://pds-geosciences.wustl.edu/mro/mro-m-crism-5-rdr-mptargeted-v1/mrocr_4001/document/crism_dpsis.pdf
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A PDS4 XML label for an InSight Instrument Context Camera image. 

The label metadata contains valuable information about the image (see the red boxes pointers): 

• The image has 3 bands. We can tell from the axis_index_order and the sequence_number values 

that the image is in band sequential order because the last index (sample) changes fastest. In 

other words, you must count through every sample in line one before moving to line two, and 

every line in band one before moving to band two. 

• The image has 1024 lines and 1024 samples per line. 

• Pixel values are stored using the SignedLSB2 data type. Numbers for this data type are two-byte 

integers in least significant byte order. 

The label provides some additional info (green and purple box pointers): 

• The file offset value tells us that the data file contains 10,240 bytes of non-image data before the 

start of the image. You may need to enter this value into your software program when reading 

the image. Note that the offset is in bytes—the data type does not matter to the offset. 

• The image data type is SignedLSB2, meaning signed two's complement two-byte integer with the 

least significant bit first. PDS allows several standard data types. Software typically knows what 

to do with this knowledge, but contact us if you need help.  

• Other values in the example's "Element_array" include a unit of measure applicable to the data 

values, along with a scaling factor and offset. These last two numbers, when present, should be 

applied to each pixel value in the image to get the actual data value for the pixel. 
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• Finally, special constants may be given. They are not applicable for this image, but sometimes an 

instrument error results in some of the image being invalid. Employing a special constant 

informs the user that pixels with a certain value, for example -999, are invalid. 

How to View PDS Images 

PDS4 Viewer 
PDS4 Viewer is a free visualization tool produced by the PDS Small Bodies Node (SBN) for PDS4 data that 

supports images, tables, spectra, and arrays. There is also a label reader for displaying labels. Note that 

this software is for PDS4 data only. For PDS3 data, look to the NASAView section of this document.  

The following is a list of the primary features of the software, pulled from the SBN Wiki:  

• Summary View: displays a summary of the available data structures in the label, giving various 

options to view them. 

• Image View: displays N-dimensional images and spectra, allowing for zoom, rotation, pan, axis-

inversion, colormap manipulation, and scaling. 

• Table View: displays all PDS4 tables and arrays as tables, including arbitrarily nested GROUP 

fields (sub-tables).  

• Plot View: allows plotting PDS4 table columns against each other, including error bars. 

• Label View: Easy, human-readable, access to meta-data (such as structure labels, display settings, 

spectral characteristics, etc.). 

Installation and more information: https://sbnwiki.astro.umd.edu/wiki/PDS4_Viewer  

In this section, we will go over the basic functionality of PDS4 Viewer. To follow along, click the example 

data links below and download the image and label files. Note that for images hosted by the PDS 

Imaging Node at JPL you will need to right click the webpage and click “Save Page As…” to download the 

image.  

Example image and label:  

https://planetarydata.jpl.nasa.gov/img/data/mars2020/mars2020_hazcam_ops_calibrated/data/sol/006

58/ids/rdr/fcam/FRF_0658_0725352317_817RAD_N0320262FHAZ08111_0A0295J01.IMG  

https://planetarydata.jpl.nasa.gov/img/data/mars2020/mars2020_hazcam_ops_calibrated/data/sol/006

58/ids/rdr/fcam/FRF_0658_0725352317_817RAD_N0320262FHAZ08111_0A0295J01.xml  

To get started, open PDS4 Viewer, click File, then Open…. Navigate to the example image label 

(FRF_0658_0725352317_817RAD_N0320262FHAZ08111_0A0295J01.xml) and click Open. Notice that 

only the label is available to be opened because the software is looking for XML files. If you were to 

change the file search type to All Files and try to load the IMG file instead, you would get an error. The 

viewer reads required information from the XML label to open the image. The image file should be 

stored in the same directory as the XML file so the program has access to it. 

https://sbnwiki.astro.umd.edu/wiki/PDS4_Viewer
https://pds-smallbodies.astro.umd.edu/
https://sbnwiki.astro.umd.edu/wiki/PDS4_Viewer
https://sbnwiki.astro.umd.edu/wiki/PDS4_Viewer
https://planetarydata.jpl.nasa.gov/img/data/mars2020/mars2020_hazcam_ops_calibrated/data/sol/00658/ids/rdr/fcam/FRF_0658_0725352317_817RAD_N0320262FHAZ08111_0A0295J01.IMG
https://planetarydata.jpl.nasa.gov/img/data/mars2020/mars2020_hazcam_ops_calibrated/data/sol/00658/ids/rdr/fcam/FRF_0658_0725352317_817RAD_N0320262FHAZ08111_0A0295J01.IMG
https://planetarydata.jpl.nasa.gov/img/data/mars2020/mars2020_hazcam_ops_calibrated/data/sol/00658/ids/rdr/fcam/FRF_0658_0725352317_817RAD_N0320262FHAZ08111_0A0295J01.xml
https://planetarydata.jpl.nasa.gov/img/data/mars2020/mars2020_hazcam_ops_calibrated/data/sol/00658/ids/rdr/fcam/FRF_0658_0725352317_817RAD_N0320262FHAZ08111_0A0295J01.xml
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When the label is initially opened, PDS4 Viewer shows the summary view of the product. This quickly 

displays information about the file and gives all relevant options for working with the data in the View 

section. 

 

Summary view of the example product. 

To open the label viewer to read the metadata, click Label. 

 

 

Object Label view.  

For the full label, click View in the label view window, then Full label. 

 

 

To open the image, under the View tab click Image. 
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Summary view of the example product 

 

Image view.  

There are several options for quickly adjusting and editing the image in the toolbar. Under Zoom in 

addition to changing the zoom level, you can rotate and invert the image and toggle the pan feature.  

The Color tab provides a list of color gradations as well as the ability to invert the colormap. Also 

included in this tab is a color bar that can be placed either vertically or horizontally.  

If you have altered the image and would like to save your changes, you can do so by clicking File → Save 

Image and saving the image in your preferred format. 

NASAView 
NASAView is a software package that supports PDS3 products. Although new PDS data archives are being 

released in the PDS4 data format, some older PDS data still exist in the PDS3 format and have not yet 

been converted to PDS4. NASAView can be used to view these products.  

Installation and more information: https://pds.nasa.gov/tools/about/pds3-tools/nasa-view.shtml  

One-band grayscale example image:  

https://pds-geosciences.wustl.edu/mer/mer1-m-pancam-2-edr-sci-

v1/mer1pc_0xxx/data/sol0710/1p191228020esf64ksp2583l6c1.img 

NASAView is similar to PDS4 Viewer but is used exclusively for PDS3 images. However, for the three-band 

example, we will be using the same example data for NASAView as we used for PDS4 Viewer. This is 

https://pds.nasa.gov/tools/about/pds3-tools/nasa-view.shtml
https://pds-geosciences.wustl.edu/mer/mer1-m-pancam-2-edr-sci-v1/mer1pc_0xxx/data/sol0710/1p191228020esf64ksp2583l6c1.img
https://pds-geosciences.wustl.edu/mer/mer1-m-pancam-2-edr-sci-v1/mer1pc_0xxx/data/sol0710/1p191228020esf64ksp2583l6c1.img
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possible because this product has both a detached PDS4 label (used by PDS4Viewer) and an embedded 

PDS3 label (used by NASAView). 

Loading a single band image: 

To get started, install the software from the installation link above. Then open the program and you 

should see a screen like the one shown below. 

 

NASAView home screen.  

To load the data, click File → Open Object and navigate to where you stored the image file, and open 

1p191228020esf64ksp2583l6c1.img.  

A window containing the image will open, and will need to be resized to display the entire image.  



10 
 

  

Example grayscale Pancam image loaded into NASAView.  

The Image section of the toolbar gives you the option to invert and stretch the display and to stretch the 

image itself. Under Label, you can see object parameters, object hierarchy, and the full label. Also 

contained in this section are the band selection and band min/max options, which are not available for 

this single-band image. Under Options, you can view the histogram. Also in the histogram feature is the 

ability to apply different color palettes. If you make changes to the image and want to save a new copy of 

the image, click File followed by one of the save options such as Save GIF or Save JPEG.  

Loading a three-band image:  

Three-band RGB example image (with embedded label): 

https://planetarydata.jpl.nasa.gov/img/data/mars2020/mars2020_hazcam_ops_calibrated/data/sol/006

58/ids/rdr/fcam/FRF_0658_0725352317_817RAD_N0320262FHAZ08111_0A0295J01.IMG  

Now we are going to load the three-band Perseverance rover image. To do so, you once again click File 

→ Open Object and navigate to where you have saved the image file 

FRF_0658_0725352317_817RAD_N0320262FHAZ08111_0A0295J01.IMG 

This time, upon loading the image, you will see the Band Selection menu and be prompted to choose 

how the bands should be interpreted by the software. Leave the Red Band value unaltered, use the G 

https://planetarydata.jpl.nasa.gov/img/data/mars2020/mars2020_hazcam_ops_calibrated/data/sol/00658/ids/rdr/fcam/FRF_0658_0725352317_817RAD_N0320262FHAZ08111_0A0295J01.IMG
https://planetarydata.jpl.nasa.gov/img/data/mars2020/mars2020_hazcam_ops_calibrated/data/sol/00658/ids/rdr/fcam/FRF_0658_0725352317_817RAD_N0320262FHAZ08111_0A0295J01.IMG
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Incr button to set the Green Band value to 2, then use the B Incr button to set the Blue Band value to 3. 

Note: the values you will be editing are to the left of the Decr/Incr buttons. On this screen, you also have 

the option to adjust the intensity of each band individually. If you decide later that you want to change 

any of these values, you can reopen the Band Selection screen again at any time under the Label 

heading in the toolbar.  

 

Band selection menu in NASAView.  

Once the bands have been set, click Apply Selections. 

Again, you will have to adjust the windows to display the entire image. 
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Example image opened in NASAView.  

Manipulating PDS Data with Transforms and Conversions 
In the absence of a browse collection in the bundle you are working with, you might want to create 

browse images yourself. Other times you might be working with software that needs a specific file type 

to use the data (ENVI requires .hdr files to read map projection information for satellite data for 

example). Learning how to do simple conversions from PDS image and label files to other file types like  

.jpg, .png, .tif, and .hdr can make working with PDS data simpler. This section will demonstrate how to do 

that kind of conversion using either PDS Transform or the Geospatial Data Abstraction Library (GDAL).  

PDS Transform  
Installation and more information:  

https://nasa-pds.github.io/transform/install/index.html  

Transform is a PDS tool that can be used to perform file transformations on images, like converting a .img 

to a .tif file or converting PDS3 labels to PDS4 labels and vice versa. The tool supports many different 

format types. Follow the Installation and more information link for the complete list.  

For the example in this section, we will use transform to convert the Perseverance rover image used in 

the PDS4 Viewer section from a .img file to a .tif file. 

Example image and label files:  

https://nasa-pds.github.io/transform/install/index.html
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https://planetarydata.jpl.nasa.gov/img/data/mars2020/mars2020_hazcam_ops_calibrated/data/sol/006

58/ids/rdr/fcam/FRF_0658_0725352317_817RAD_N0320262FHAZ08111_0A0295J01.IMG  

https://planetarydata.jpl.nasa.gov/img/data/mars2020/mars2020_hazcam_ops_calibrated/data/sol/006

58/ids/rdr/fcam/FRF_0658_0725352317_817RAD_N0320262FHAZ08111_0A0295J01.xml  

The general command format for PDS Transform is to input either a PDS3 or PDS4 label and specify a 

supported file format for the transformation. For this example, we will use the detached PDS4 label to 

create a TIF. After completing the installation, open a command line window and set your working 

directory using the command cd followed by the location of the label and image files. For example:  

cd C:\Users\g.bowen\Desktop\PDSTransfrom 

Then, enter the following command:  

transform FRF_0658_0725352317_817RAD_N0320262FHAZ08111_0A0295J01.xml -f tif 

Example calling command:  

 

… 

Example output:  

 

The created tif should now be in your working directory.  

https://planetarydata.jpl.nasa.gov/img/data/mars2020/mars2020_hazcam_ops_calibrated/data/sol/00658/ids/rdr/fcam/FRF_0658_0725352317_817RAD_N0320262FHAZ08111_0A0295J01.IMG
https://planetarydata.jpl.nasa.gov/img/data/mars2020/mars2020_hazcam_ops_calibrated/data/sol/00658/ids/rdr/fcam/FRF_0658_0725352317_817RAD_N0320262FHAZ08111_0A0295J01.IMG
https://planetarydata.jpl.nasa.gov/img/data/mars2020/mars2020_hazcam_ops_calibrated/data/sol/00658/ids/rdr/fcam/FRF_0658_0725352317_817RAD_N0320262FHAZ08111_0A0295J01.xml
https://planetarydata.jpl.nasa.gov/img/data/mars2020/mars2020_hazcam_ops_calibrated/data/sol/00658/ids/rdr/fcam/FRF_0658_0725352317_817RAD_N0320262FHAZ08111_0A0295J01.xml
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Tif created with PDS Transform.  

GDAL  
The Geospatial Data Abstraction Library (GDAL) is a computer software library available for free. With 

gdal_transform you can perform transformations on a wide variety of file types. Another useful tool, 

gdalinfo, quickly and easily displays metadata information.  

There are multiple install options. The examples in this document use the OSgeo4W platform which can 

be downloaded from the link marked with an asterisk (*) below. Choose whichever install option is the 

most convenient for your particular use case. 

• GDAL website: https://gdal.org/download.html  

• Conda: https://anaconda.org/conda-forge/gdal  

• GIS Internals Site: https://www.gisinternals.com/release.php  

• *QGIS OSGeo4W platform: https://www.qgis.org/en/site/forusers/alldownloads.html#osgeo4w-

installer  

o The following YouTube tutorial (not produced by PDS) could be helpful: 

https://youtu.be/4viTd3n9C9g 

List of programs in the GDAL library: https://gdal.org/programs/index.html  

For this section, we will limit the scope of the examples to cover two primary tools: gdal_translate and 

gdalinfo. For those who want to go more in depth, follow the link above to view the full list of available 

raster programs. 

Creating GeoTIFFs with gdal_translate 

Example data:  

https://pds-geosciences.wustl.edu/mro/mro-m-crism-5-rdr-mptargeted-

v1/mrocr_4001/mtrdr/2009/2009_110/hrs0001224c/hrs0001224c_07_if174j_mtr3.img  

https://gdal.org/download.html
https://anaconda.org/conda-forge/gdal
https://www.gisinternals.com/release.php
https://www.qgis.org/en/site/forusers/alldownloads.html#osgeo4w-installer
https://www.qgis.org/en/site/forusers/alldownloads.html#osgeo4w-installer
https://youtu.be/4viTd3n9C9g
https://gdal.org/programs/index.html
https://pds-geosciences.wustl.edu/mro/mro-m-crism-5-rdr-mptargeted-v1/mrocr_4001/mtrdr/2009/2009_110/hrs0001224c/hrs0001224c_07_if174j_mtr3.img
https://pds-geosciences.wustl.edu/mro/mro-m-crism-5-rdr-mptargeted-v1/mrocr_4001/mtrdr/2009/2009_110/hrs0001224c/hrs0001224c_07_if174j_mtr3.img
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https://pds-geosciences.wustl.edu/mro/mro-m-crism-5-rdr-mptargeted-

v1/mrocr_4001/mtrdr/2009/2009_110/hrs0001224c/hrs0001224c_07_if174j_mtr3.lbl  

https://pds-geosciences.wustl.edu/mro/mro-m-crism-5-rdr-mptargeted-

v1/mrocr_4001/mtrdr/2009/2009_110/hrs0001224c/hrs0001224c_07_if174j_mtr3.hdr  

For this example, we are going to create a GeoTIFF from a CRISM MRTDR example image and 

supplementary files. Make sure the .img, .lbl, and .hdr files are all located in the same working directory. 

Although the image will be used as the input file for transformations, GDAL needs to be able to obtain 

information from the .lbl and .hdr files as well. 

Once GDAL is installed, open the OSGeo4W shell or appropriate command line. To check that your 

current session has access to GDAL, run the command gdal_translate. If you have properly set up GDAL, 

you should see something like the screenshot below.  

 

Testing GDAL installation by running the gdal_translate command with no specified dataset.  

 

To get started, you need to set the path to your working directory. To do this use the command cd x 

where x is the working directory path.  

Next, we are going to run a simple gdal_translate command to create a GeoTIFF. First, we input the 

following command: 

gdal_translate -of GTiff hrs0001224c_07_if174j_mtr3.img hrs0001224c_07_if174j_mtr3_gtiff.tif 

Example calling command:  

https://pds-geosciences.wustl.edu/mro/mro-m-crism-5-rdr-mptargeted-v1/mrocr_4001/mtrdr/2009/2009_110/hrs0001224c/hrs0001224c_07_if174j_mtr3.lbl
https://pds-geosciences.wustl.edu/mro/mro-m-crism-5-rdr-mptargeted-v1/mrocr_4001/mtrdr/2009/2009_110/hrs0001224c/hrs0001224c_07_if174j_mtr3.lbl
https://pds-geosciences.wustl.edu/mro/mro-m-crism-5-rdr-mptargeted-v1/mrocr_4001/mtrdr/2009/2009_110/hrs0001224c/hrs0001224c_07_if174j_mtr3.hdr
https://pds-geosciences.wustl.edu/mro/mro-m-crism-5-rdr-mptargeted-v1/mrocr_4001/mtrdr/2009/2009_110/hrs0001224c/hrs0001224c_07_if174j_mtr3.hdr
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… 

Example output: 

 

Explanation: 

-of GTiff sets the output file to be a GeoTIFF 

Then, specify the input image filename and the desired output GeoTIFF filename with the extensions 

included in both. 

Because this data has 489 available bands, GDAL needs additional creation options to interpret the 

image as RGB. Without this information, the GeoTIFF will be grayscale. The next command sets the RGB 

bands.  

gdal_translate -of GTiff -b 304 -b 122 -b 41 -colorinterp red,green,blue 

hrs0001224c_07_if174j_mtr3.img hrs0001224c_07_if174j_mtr3_gtiff.tif 

Example calling command:  

 

… 

Example output:  

 

Explanation:  

-b <x> set the three-bands you want for RGB. These are chosen from the 489 available bands based on 

the MTRDR documentation for IMG products. 

-colorinterp red,green,blue sets the RGB order for the bands to be interpreted. -b 304 here is set to red, 

-b 122 is green, and -b 41 is blue.  
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The created GeoTIFF (with an optimized linear stretch applied) and associated band information opened in ENVI.  

 

At this point, you could take the GeoTIFF into the GIS software of your choice and apply a stretch (as 

shown in the screenshot above), or you can adjust it further using the -scale and -exponent creation 

options. You can read more about those creation options under the gdal_translate description on the 

GDAL website. This GeoTIFF is not very convenient for quickly getting a visual understanding of the data 

without using GIS software. For this, we can use gdal_translate to create a quick browse product that can 

be easily opened in an image viewer application.  

Browse PNGs with gdal_translate 
To continue our brief display of the capabilities of gdal_translate, we will go over creating an 8-bit 

browse PNG. To do so, we run a similar command as earlier, with additional creation options added to 

make extra adjustments to the outputted PNG. Here is that command:  

gdal_translate -of PNG -ot Byte -scale -b 304 -b 122 -b 41 -colorinterp red,green,blue 

hrs0001224c_07_if174j_mtr3.img hrs0001224c_07_if174j_mtr3_browse.png 

Example calling command: 

 

... 

Example output: 

 

https://gdal.org/programs/gdal_translate.html#gdal-translate
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Explanation:  

-of PNG sets the output file type to PNG.  

-ot Byte sets the output image bands to have an 8-bit data type.  

-scale computes the pixel range of the source image and maps this range to the 0 to 255 range. This 

behavior is the default, but you can also specify the input and output range you want to scale.  

Note: The nodata values being clamped to 255 is a result of creating the 8-bit PNG browse from a 16-bit 

image. 

The resulting PNG browse image can now be opened in a photo viewer: 

 

8-bit PNG browse image created with gdal_translate.  

gdalinfo  
The gdalinfo command can be particularly useful when working with image data in GDAL. This command 

displays various information and metadata about the file you are interested in. To run the command, 

simply type gdalinfo followed by the filename with the extension included. For example, if we want to 

look at the GeoTIFF we created in the earlier section to see if we properly assigned the bands, we could 

run the following gdalinfo command:  

gdalinfo hrs0001224c_07_if174j_mtr3_gtiff.tif 

 

Example calling command: 

 

… 

Example output: 
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The command starts at the bottom of the information, where the RGB bands are located, but you can 

scroll up for more information on map projection and wavelength. There is a lot of information for this 

GeoTIFF, so it cannot all be included in a screenshot, but here is what you should see after running the 

command. 

The command output shows that Band 1 is interpreted as red, Band 2 as green, and Band 3 as blue. To 

confirm the bands have been properly assigned, scroll up in the gdalinfo list and look at the wavelengths 

of bands 304, 122, and 41 and make sure that the wavelengths are the same as the assigned RGB bands 

1, 2, and 3.  

For example, here is the wavelength for Band 304: 

 

This wavelength matches the value assigned to Band 1. 

 

For any questions relating to the content of this document, reach out to the PDS Geosciences Node at 

geosci@wunder.wustl.edu.  

 

mailto:geosci@wunder.wustl.edu
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